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Warranty

All equipment supplied by Trio Datacom Pty Ltd (As 
of 1 January 2009) is covered by warranty for faulty 
workmanship and parts for a period of three (3) years 
from the date of delivery to the customer. During the 
warranty period Trio Datacom Pty Ltd shall, at its option, 
repair or replace faulty parts or equipment provided the 
fault has not been caused by misuse, accident, deliberate 
damage, abnormal atmosphere, liquid immersion or 
lightning discharge; or where attempts have been made by 
unauthorised persons to repair or modify the equipment.  

The warranty does not cover modifications to software. 
All equipment for repair under warranty must be returned 
freight paid to Trio Datacom Pty Ltd or to such other 
place as Trio Datacom Pty Ltd shall nominate. Following 
repair or replacement the equipment shall be returned to 
the customer freight forward. If it is not possible due to 
the nature of the equipment for it to be returned to Trio 
Datacom Pty Ltd, then such expenses as may be incurred 
by Trio Datacom Pty Ltd in servicing the equipment in situ 
shall be chargeable to the customer.  

When equipment for repair does not qualify for repair or 
replacement under warranty, repairs shall be performed 
at the prevailing costs for parts and labour. Under no 
circumstances shall Trio Datacom Pty Ltd’s liability 
extend beyond the above nor shall Trio Datacom 
Pty Ltd, its principals, servants or agents be liable for 
the consequential damages caused by the failure or 
malfunction of any equipment.

Part A – Preface

Related Documentation
TView+ Diagnostics Quick Start Guide 

Revision History

Issue: 09-14 - (September 2014) Added Q UHF 

Issue: 05-17 - (May 2017) Added Q VHF

Important Notice

© Copyright 2017 Schneider Electric Pty Ltd All Rights 
Reserved

This manual covers the operation of TView+ Diagnostics 
software. Specifications described are typical only and are 
subject to normal manufacturing and service tolerances.

Trio Datacom Pty Ltd reserves the right to modify the 
equipment, its specification or this manual without 
prior notice, in the interest of improving performance, 
reliability or servicing. At the time of publication all data is 
correct for the operation of the equipment at the voltage 
and/or temperature referred to. Performance data 
indicates typical values related to the particular product.

This manual is copyright by Trio Datacom Pty Ltd. All rights 
reserved. No part of the documentation or the information 
supplied may be divulged to any third party without the 
express written permission of Trio Datacom Pty Ltd.

Same are proprietary to Trio Datacom Pty Ltd and 
are supplied for the purposes referred to in the 
accompanying documentation and must not be used 
for any other purpose. All such information remains 
the property of Trio Datacom Pty Ltd and may not be 
reproduced, copied, stored on or transferred to any 
other media or used or distributed in any way save for 
the express purposes for which it is supplied.

Products offered may contain software which is 
proprietary to Trio Datacom Pty Ltd. However, the offer of 
supply of these products and services does not include 
or infer any transfer of ownership of such proprietary 
information and as such reproduction or reuse without the 
express permission in writing from Trio Datacom Pty Ltd 
is forbidden. Permission may be applied for by contacting 
Trio Datacom Pty Ltd in writing.

Related Products
ER450 Remote Data Radio

EB450 Base/Repeater Station

EH450 Hot Standby Base Station

ER45e Ethernet Radio

EB45e Ethernet Base Station

EH45e Hot Standby Base Station

MR450 Remote Data Radio

KR900 | KR240 Data Radio

JR900 | JR240 Ethernet Radio

QR150 | QR450 Data Radio

QB150 | QB450 Data Radio

QP150 | QP450 Dada Radio

QH150 | QH450 Data Radio



 4  Document Number: 0100SM1402   Issue: 05-17

Introduction

This section covers the installation and operation of 
TView+ Diagnostics software. Version 3.25.0 onwards 
should be used.

Overview

The Diagnostic Controller is a Windows© based program, 
that can be run on a standard desktop or laptop PC.

The software runs in the 32 or 64 bit Windows 
environment and offers many options and configurations 
which are easily accessible via pop-up windows. These 
include group or timed polling, remote switching of 
duplicated base stations, viewing of data bases, logging 
and trending of real time parameters , etc.

The Diagnostic Controller is installed to run as a stand-
alone package, or as part of the TView+ Management 
Suite (See E, M ,K, J or Q  product user Manuals for more 
product specific details relating to TView+ Management 
Suite).

TView+ facilities allow retrieval of diagnostic parameters 
and statistical performance indicators from each radio. 
This helps to provide users tools for maintenance, 
commissioning and system diagnosis in a single package.

The general operating parameters that can be obtained 
from most radio models are:

• Last RSSI level.

• Last transmitted power level.

• Receive frequency offset. 

• Power supply voltage level.

• Current internal temperature.

• VSWR 

TView+ creates a virtual diagnostics controller to allow 
radio devices to add destination addressing in order 

Retrieved diagnostics are displayed on the controller’s 
screen in a “quick read” format of bar graphs, as well as 
detailed response listings.

Trio radios will only work with TView+ Diagnostics 
software, if the ‘Diagnostics option’ was ordered upon 
purchase. To check this, review the radio model number 
against the model number matrix within the product 
data sheet. The Diagnostics option is generally included 
with new products shipped, however, in some cases it 
may not be installed. It can be installed at a later stage 
via the configuration programmer (E & K Series only). 
Contact your supplier for further details.

Part B – TView+ Diagnostics   

Introduction
For radios with a system port, the TView+ configuration 
programmer can be used to verify the diagnostics 
option is installed in the radio. If the diagnostics option is 
installed, it will be stated in the Unit Information dialogue 
box when the radio is “Read”.

For Ethernet radios, the model number is shown within 
the products web user interface.

Features

• 32/64 Bit Windows Based User Software.

• Graphical presentation.

• SCADA style features such as database, trending, 
networking, etc.

• Able to interrogate and display operating 
parameters of each radio.

• Provides performance data of Trio radio good/bad 
frames received, packet transmission test results, 
transmitted packet sizes, channel usage, etc. 

• Perform statistical packet transmission test to 
remote Trio radios.

• Provides powerful network tools such as 
channel occupancy statistics, average received 
transmission duration, etc.

• Can be set to background poll radio system for 
continuous system monitoring and logging.

• Provides time/date stamped Status and event 
logging/reporting.  A relational database is created 
and managed using Microsoft Jet database engine 
Ver3.5. The database file, which is an “.mdb” file, 
can be accessed with external programs such as 
Microsoft Access.
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Installation & Start-up

Programmer and Diagnostics Utilities

The TView+ Diagnostics software is normally shipped as 
part of the TView+ Management Suite which includes the 
E, M & K Series programmers. It can be downloaded from 
the support section of the Schneider Electric website as 
a zipped executable package. This user manual covers 
the installation as part of the TView+ Management Suite.

The installation of this Software Suite is a 2 step process. 

Step 1 involves the typical installation of the TView+ 
Management Suite and will install the E,M & K Series 
Programming Software together with documentation for 
relevant products.

Step 2 installs the TView+ Diagnostics Software and is 
optional. 

STEP 1: Installation - TView+ Management Suite

If a previous version of the TView+ Management Suite 
has been installed on your PC, un-install it via Control 
Panel “Add/Remove Programs”.

• Close other programs currently running.

• Place the CD-ROM in the drive on the PC. (or 
extract files from zip package)

• In Windows Explorer browse and double click on 
the file called TView+ Management Suite_Rxxx_
Installer.exe 

• After the installer starts follow the directions.

STEP 2: Installation - TView+ Diagnostic Software

If a previous version of the “TView+” software has been 
installed on your PC, un-install it via Control Panel “Add/
Remove Programs”.

• Close other programs currently running.

• Place the CD-ROM in the drive on the PC. (or 
extract files from zip file)

• Double click on the file called setup.exe

• After the installer starts follow directions.

Diagnostics Auto Start-up (Windows)

Diagnostics can automatically start upon boot-up of 
Windows. 

To do this, create a shortcut on your desktop with 
the following Location: “C:\Program Files (x86)\Trio 
Datacom\TViewDiagnostics\TrioWinDiags.exe”

(If TView Diagnostics has been installed within a custom 
location, use that directory instead).

Locate the Startup folder in windows: To locate the 
current user’s startup folder, click on Start>All Programs 
and then right click on the startup folder. Choose open 
from the menu. 

Drop the new shortcut from the desktop into this folder 
and restart your computer. TView Diagnostics should 
now load and begin group polling at Windows boot up.

TView+ Front Panel

When started the TView+ front panel appears. The larger 
buttons permit each of the three utilities to be started. 
Diagnostics will start when you click on the “Diagnostics” 
button.

Access to local help and an exit facility are provided by 
the remaining 2 buttons.
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Part C – Setup Instructions

The diagnostics process is based on a series of polls 
being transmitted to the remote radio with each having 
its own unique assigned address (based on the serial 
number) which is factory preset.

When a diagnostic poll is received by a radio, it checks to 
see if it is addressed to itself, and if so, it responds with its 
diagnostic data back to the TView+ Diagnostics software.  
If it is not addressed to itself, the radio simply “passes the 
message on”, and does not respond to the diagnostics 
software. In a multi-layer system, several “pass on’s” may 
occur before the destination radio is reached.

The radio’s diagnostic response message is addressed to 
the TView+ Diagnostics software (Controller Address), and 
as each radio in the “chain” decodes this message it will 
“pass it back”, eventually the message reaches the TView+ 
software for processing.

The TView+ software uses a database to store each 
radio ‘s associated data (i.e.S Serial number, assigned 
name, location, alarm detection limits, SID code address, 
IP Address (e-Diags only), radio pairing information (Hot 
Standby), status poll response data, alarm detection, 
etc).

The radio’s address is the serial number of the radio 
which is factory preset. The name is any name that 
the user wishes to attach to the radio. This name is 
then used to address the unit for access to diagnostic 
facilities.

Diagnostic values within responses from each radio 
should have boundary limits placed on them. If a value 
received is outside of these limits, an alarm can  be 
detected and reported. For instance, the DC supply volts 
can have a lower limit of 12V, and an upper limit of 16V. 
Should a response value report the DC volts is at 11V 
DC, then TView+ will detect an alarm and report it.

A radio can be excluded from a poll sequence by removing 
it from the poll group. Intensive polling of a single radio is 
possible using the Individual polling facility.

A poll “run” can be set up. A time can be designated for the 
controller to poll each of the radios in the system. This may 
be useful for systems that have a low traffic period where 
diagnostics can be “slotted in”, thereby spreading the data 
throughput of the system more efficiently.

The screen is divided into three main scrolling sections — 
Status Polls, Local Alarms and Base Station Activities. The 
status poll section displays current poll activity while the 
local alarm section displays any detected alarms. The Base 
Station activity section displays any changeovers that have 
occurred to Hot Standby Units — if no Hot Standbys are 
within the database, this section will remain blank.

A database is created and managed using Microsoft Jet 
database engine. The database file, which is an “.mdb” 
file, can be accessed with external programs such as 
Microsoft Access.  Polls and detected alarms are time 
and date stamped and saved to the database. Database 
entries can be sorted and printed.

Introduction (Polled Diagnostics)
For some multi layer, Serial only systems, Stream 
Identifier (SID) codes can be used to route diagnostics 
messages to specific locations. Serial only Trio radios 
can be assigned a custom SID address (while SID 0 is 
permanently enabled).

Trio radios store packet statistics available for retrieval. 
The TView+ Diagnostic controller can poll for these 
values and calculate packet and BER rates, network 
efficiency, bandwidth utilisation, and radio link integrity.  
These network analysis features are an invaluable tool for 
larger networks.

Introduction (Automatic Diagnostics)

Applies to E, M (Q operating in E/M compatibility mode) 
& K Only. 

Automatic diagnostics allows the monitoring of radios in 
a network without the need to generate a poll.

The data returned in automatic diagnostics is fixed 
in nature and includes the 5 standard parameters. 
Automatic diagnostics works by appending an unsolicited 
fixed format diagnostic data packet to the end of a user 
data message. Subsequently, automatic diagnostics can 
only work when user data is being transferred by the 
radio.

Automatic diagnostics can be useful where polled 
diagnostics could interfere with user data transfer and 
cause collisions. For more information on configuration of 
automatic diagnostics refer to the product user manual.

For automatic diagnostic messages to be processed 
by the TView+ software the unit should be configured 
in the database. Automatic diagnostic response can be 
identified in the “status poll” window as they are Cyan 
colored text. 

Radio Connection

There are two methods of connecting to the diagnostics 
driver within a Trio radio:

Serial - connects via a COM port on the controller PC 
and the “System Port” on the radio (Port “A & B” can be 
used if required). 

Ethernet (eDiags) - connects via Ethernet from the 
controller PC, either directly into an Ethernet capable 
radio, or into a Serial terminal server.

When “Settings” is selected, the controller will interrogate 
the computer’s com port and display the available ports. 
Possible valid com ports are 1–99 or “None”. Choose the 
desired port. Exit TView+ Diagnostics if it is required to 
free the com port for use with other programs.

The radio port should have its SID codes enabled, and 
have the SID code set to the system diagnostics SID 
(normally this is set to “00”).

The data format used is the SLIP protocol, running at 
19200 baud, No parity, 8 data bits and 1 stop bit.  More 
details on “SLIP Protocol” can be found in Tech-Note 8.
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Add/Edit/Delete

After creating a New database or Opening an existing 
database, the Add/Edit/Delete menu can be accessed.

New/Open

These options allow you to create a new database or 
open an existing database file. When creating a new 
database, supply the name of the new database file. 
After creation the software will automatically swap to the 
File - Add/Edit/Delete menu.

When the Diagnostic controller starts, a presentation 
screen is displayed which will then lead you into the main 
diagnostics screen. This is where the major functions of 
the controller are accessed.

The main screen presents the operator with the typical 
Windows pull down type menu bars - “File”, “Settings”, 
etc. Icons of the commonly used selections are also 
provided across the top of the screen.

This screen is divided into 3 main sections:

1. Status reports screen which displays the poll results 
obtained.

2. Local Alarms screen which displays detected alarms.

3. Base Station Activity screen which displays any 
changeovers that occur with Hot Stand-by Base Stations 
within the system.

Each column of these sections can be individually re-
ordered left to right. By default the unit serial number 
follows the Unit Name but, for example, RSSI could be 
moved next to the Unit Name to make results clearer 
when checking antenna alignment.

Automatic Diagnostics “Status Polls” appear as CYAN in 
colour.

The line above Status Polls is a “Processing Status Bar”.  It can 
display messages about error detection and poll processing.

The bottom row of the screen also displays a summary 
of the configured parameters such as which COM port 
is being used, whether SID codes are on or off, whether 
polling is enabled or disabled, current database path and 
file name, etc.

Menu Selection

File Menu

To utilise the Remote Diagnostics facilities, create a 
database which includes the individual serial numbers, 
alarm detection parameters and various other 
parameters of each radio (this applies to both polled and 
automatic diagnostics). 

Some options are only available for particular types of 
radios.

Main Menu 
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Selected Unit

Selected Unit is a pull down selection box, for selecting a 
radio from the database to view or edit. This will be blank 
if no radios exist in the database.

Unit Name and Location

When entering a radio into the database, give it a unique 
name for identification purposes (This parameter is 
required, max. 20 characters). 

Location allows the user to enter descriptions of sites 
and their locations (This parameter is optional, max. 20 
characters).

Unit Serial Number

This is the factory preset unique serial number of the 
radio. This can be obtained from the label located on the 
radio or read from the radio using the Programmer or 
web user interface. 

SID Code (Diagnostic Stream Identifier)

This is the SID code address number being used by the 
radio for the diagnostics stream and is normally set to 
0. Match the diagnostics stream ID  with the diagnostics 
SID configured in the radio (SID 0 is always enabled).

In complex systems, units in a network can be separated 
into different areas by using different SID codes for each 
area.

In systems using Automatic Diagnostics, this SID code 
should match the SID code as configured in the radio 
configuration.

Model

This allows you to select the radio type being added to 
the database.

Select D, E, M, Q, K or J Series as required. then select 
from the following presented options:

M Series: Remote

D Series: Remote or Base

E Series: Remote or Base

K Series: Master or Remote or Bridge

J Series: Access Point or Remote or Bridge

Q Data Radio: Remote or Base

Communications Port 

Select either serial (RS-232 serial data communications 
using COM1, etc) or eDiags (Ethernet) mode. When in 
serial mode, the standard serial communications port is 
used (See Settings Menu -> Controller Settings for more 
configuration options).

When eDiags mode is selected, specify the remote IP 
address and port number. This will normally be the IP 
address and destination port number for a J-Series , Q 
Data Radio, terminal server or similar devices like the J 
Series operating in UDP connection mode. (See Settings 
Menu -> eDiags port settings for more options).

Alarm Limits

These configuration options allow the user to set thresholds 
for each radio. If the thresholds are exceeded then the 
diagnostics software will declare that the radio has detected 
an alarm. Default settings are provided.

The alarm limits available for custom configuration are :

• Temp = Internal Modem Temperature (-40 to +70)

• RxSig = Receiver RF Signal Strength (-150 to -20)

• TxPwr = Transmitter RF Power (0 to 45)

• DC Volts = Radio Supply Voltage (8V to 30V)

• AFC Freq (E & Q data radios Only) = Radio      
Frequency offset (-6000Hz to +6000Hz)

• VSWR (E, K, J & Q Only) = Antenna Voltage   
Standing Wave Ratio (2:1 to 5:1)

Get defaults

To set the alarm limits back to default, select either the 
“Get Remote Defaults” or “ Get Base Defaults” button 
(available for licensed radios only). If you wish to over-
ride the default limits, adjust the limits as required and 
then Click “Save Custom Limits”. The default values 
for the type of unit selected (i.e.: either base station or 
remote) will now be updated with the new limits. 

Base Inputs (Base Stations & HSC Only) 

Base stations have digital inputs which can be monitored 
for a change in state and will indicate alarm detection 
accordingly. 

Hot Standby Base Pairing (HSC Only)

In a Hot Stand-by configuration two base stations are 
connected to one Hot Stand-by controller. In the TView+ 
diagnostics database setup both base stations should 
be paired together for correct operation of diagnostics. 
In a hot stand-by configuration, only one base station 
can be on-line (i.e.: able to transmit) at any one time. 
Diagnostics is still available from the off-line base 
stations (via the on-line base station).

This option is only available if more than one base is 
configured in the database.

Add New Button

Click this button to add a new radio to the database.  
The Selected Radio, Name, Location, Radio Serial 
numbers and Hot Stand-by Base Pairing fields will be 
cleared, ready for the entry of a new radio.  After filling in 
the details click the “Apply Changes To Database” button 
to complete entry.

Apply Changes to Database Button

Can apply changes that have been made to selected 
radios in the data base. Additions and changes made 
on the screen require the selection of this button, to be 
saved into the database. This should be done before 
selecting a new serial number/unit. 
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Delete Button

Allows deletion of radios from the database. Deleting a 
radio from the database will also delete the associated 
status poll and alarm detection history of that radio.

A selection list of serial numbers will appear.  Select one 
or a group at a time and then press the “Delete” button 
on the selection box.

Esc Key

Press this key on the keyboard to clear a new entry 
before it has been applied to the database. 

Exit Button

Press this button to exit the Add/Edit/Delete menu area.

Advanced

Click this button to modify advanced radio unit settings.

Alarm Priority : Radios can be configured as either High 
or Low priority. See Settings -> E-mail and Local Alarm 
Reporting menus for more information on unit priority 
and alarms.

Poll Attempts : This parameter specifies the number of 
times a diagnostics poll (from the diagnostics software) 
is not answered by a radio unit before a No Ack alarm is 
generated.

Poll Response Timeout : This parameter specifies the 
time (in seconds) the diagnostics software will wait for a 
response to a diagnostics poll.

Radio Control Data : 

Firmware : The radio’s current firmware version. 
Control Data Rx’ed : Indicates calibration status of 
diagnostics. 
Paired Unit : Serial No of other base in a Hot Stand-by 
Configuration (HSC Only) 
Paired State: Indicates if paired base is currently the on-
line or off-line unit (HSC Only)

System Status :

Diagnostics : Enabled or Disabled 
Base Station : Indicates if unit is a Remote or Base 
Station 
Firmware Packs : (Base and HSC Only) 
    Radio : Base Station Firmware Version 
    Display : Base Station Display controller firmware 
version 

Last Poll Results :

Temp : Radio Temperature 
Rx Sig : RX Signal Strength 
Fwd PWR : Forward TX Power 
Rev PWR : Reverse TX Power 
VSWR : Voltage Standing Wave Ratio 
    - VSWR has white background when less than 2.0:1 
    - VSWR has yellow back ground when greater than 
2.0:1 but less than 3.0:1 
    - VSWR has red background when greater than 3.0:1 
DC Volts : Supply Voltage 
Freq Offset : RX Freq Offset 
Date : Date of Last Poll 
Time : Time of Last Poll

View Unit Details 

The View Unit Details screen shows the “selected unit” 
alarm detection limits and last poll results (radio and 
firmware information). This page will also auto refresh 
(every 6 seconds) if the unit selected for viewing is part 
of an active single or group poll. 

The view window is different for Remote radios and Base 
Stations (with and without a Hot Stand-by Controller-
HSC).
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Database Utilities

View Unit Summary List

This screen shows a summary of units within the database. 
This list can also be printed for future reference. The listed 
radios can be sorted using any of the three columns.

Archive Between Dates 

Make copy of database (radio info only)

This facility will make a copy of the database with only 
radio information. Previous diagnostic results (logged 
information) will be removed from the existing database 
and then copied to a new file name.

This is useful when you want to copy a database from 
one PC to another as it results in a significantly smaller 
file size or as a backup file.

Compact and Repair Current Database

This facility will compact and repair the database 
currently loaded in diagnostics. 

Compact and Repair Other Database

This facility will compact and repair a database that is 
too corrupt to be loaded into diagnostics. 

.mdb File Size Limitation

Over time, the TView database can grow large enough to 
become slow to respond. It is recommended that once 
the database reaches 60 MB in size, a database archive 
is performed. (A message is presented to the user once 
the database reaches 60 MB in size).
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Settings Menu

Under this menu system, configurable parameters for 
the TView+ Diagnostics software can be customized.

Controller Settings

Poll Repetition Time

Is the time in seconds (2 to 3600 secs) between each 
status poll of the group poll cycle.  Each unit in the poll 
group will be polled in turn, at this time interval.

Timed Polling

Allows the user to schedule a period when the group poll 
will commence.  This is a useful feature for systems that 
have times of minimal traffic loading such as the early 
hours of the morning.

Start Time

Time at which the Timed poll cycle will commence. The 
time format will be as per the regional settings of the 
operating system.

Number of Cycles

This is the number of times the controller will cycle 
through the poll group when the Timed Group poll 
commences. Each unit in the poll group will be polled 
this number of times.

HSC Group Polling (HSC Only)

This is the time in seconds (2-3600) between 
consecutive polls for each Hot Standby Controller 
status display. When a single data base is being used to 
manage multiple radio networks, it may be preferable 
to open more than one HSC status window at a time. 
Diagnostics allows for up to 50 instances of the HSC 
status window. The poll repetition time is the time waited 
between each window. (ie: 3 HSC status windows with 
a time of 2 secs would take 6 seconds to complete an 
update over the three windows).

Base Digital I/O Polling (Base Only)

Is the time in seconds (2-3600) between consecutive 
polls for each base station digital I/O display. The timer 
behaves in the same way as the HSC group polling time.

Apply Changes

Applies the changes made to configuration items in this 
menu.

The controller settings menu allows the user to configure 
various setup parameters as divided into four sections.  

Polling

Controller Address 

Normally set to 1 (default). When radio networks have 
multiple TView+ diagnostics software applications 
active, use different controller addresses or system 
performance may be impacted. The range of controller 
address can be 1 to 999.

For systems using Automatic Diagnostics, match 
this address with the diagnostics controller address 
as configured in the E, M & K Series configuration 
programmer.

Enable Trunk Stream Connection 

Enabled or disabled (Default enabled).  Typical E, M ,K, J 
& Q diagnostics connections require this to be enabled. 
While, typical D series diagnostics connections require 
this to be NOT enabled. 

Auto Logging ON

When enabled collected radio data will be  stored in the 
database when polling is turned on.

Communications Port

Com Port  

With the pull down box, select the required 
communications port.  Com 1 to Com 99 are supported. 

Speed  

Select the required com port speed (9k6 or 19k2bps). 
Default is 19k2bps.

Alert Tones 

When enabled will emit a tone from the PC speaker or 
sound card when status poll alarms are detected and/or 
Base Station changeovers occur.

This menu allows the configuration of items related to polling.

Poll Setup
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Poll Group Select

This dialog box enables the adding and removing of 
radios in the automatic poll group.  Units in the Selection 
list box are available for adding to the poll group.  These 
units will not be polled during a group poll cycle. 

Units in the Poll Group list box will be polled during a 
group poll cycle.

Clicking the Save button will save any changes in the poll 
group to the database.

E-mail Alarm Reporting

This section allows the configuration of diagnostics 
e-mail alarm reporting. This facility allows detected 
diagnostics alarms to be sent to a recipient via e-mail. 

General

Enable E-mail Alarm Reporting 

If checked (ticked) enables detected diagnostics alarms 
to be sent via e-mail.

Maximum Alarm E-mails per 24 hours

Specifies the maximum numbers of E-mails that the 
diagnostics software will generate in a 24 hour period. 

E-mail alarm reset time

The time at which “maximum e-mail” counters are reset. 
Default value is 00:00 (Midnight). 

Reset E-mail Alarm counters 

Allows the manual reset of E-mail alarm counters.
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High and Low Priority Units

The E-mail alarm reporting system can apply different 
rules for units that are defined as High or Low priority in the 
database. Typically, a base station or other unit that is key 
to the entire operation of the network is normally defined 
as high priority. Other units are defined as low priority. The 
E-mail alarm reporting rules can then be defined so that 
technical support personnel can receive notification of high 
priority units when an alarm is detected.

High and Low Priority unit rules are implied in the same 
way. This section of the user manual is applicable to both.

Alarm Event Counters  

Each time TView+ Diagnostics polls a radio for its 
parameters it compares the returned result against the 
alarm detection limits as defined for that unit in the data 
base. For each instance where the result is outside the 
defined limits an alarm can be detected. This parameter 
specifies the number of alarms (events) which can be 
detected for a specific radio before an E-mail alarm can 
be generated.

Send E-mail after (n) alarms events

Specifies the number of individual radio (unit) alarm 
detection events before an E-mail alarm can be 
generated. 

Reset Alarm counters after (n) successful poll events.

Specifies the number of successful radio polls before the 
e-mail alarm counters are reset. Some radios can detect 
alarms intermittently. In order to capture detected 
alarms from intermittent radios and generate e-mail’s, 
this parameter can be set so that multiple successful 
polls are required before the e-mail alarm reporting 
system declares the radio is no longer detecting alarms.

E-mail Generation

These parameters specify the rules associated with 
generating e-mail’s on a per unit basis (i.e.: specific to 
one particular unit).

Enable verbose content in e-mail.

When checked (ticked) e-mail alarms will contain all 
diagnostics parameters. When not checked, e-mail 
alarms will only contain the radio parameters that caused 
the alarm detection. 

Minimum time between alarm E-mails (per unit)

Specifies the minimum time to expire before another 
e-mail will be generated for the same unit. 

Maximum e-mails per day per unit. 

Specifies the maximum number of e-mails per day for 
any one specific unit which has detected an alarm. This 
parameter is specified to prevent a flood of e-mails when 
a radio has detected an alarm for a long period of time.

E-mail Addressing

SMTP Server

Specifies the SMTP server IP address.

Sender Address

Specifies the e-mail address a diagnostics alarm will use 
as the “sender”  when reporting an alarm detection to 
recipients. 

Sender Name

As per “Sender Address” but specifies the sender’s name. 

Recipient(s)

Specifies the e-mail address where e-mail alarms will be 
sent to. Multiple e-mail addresses can be specified, each 
one separated with a comma.

CC(s)

As per Recipient(s). See above.

Login Authentication

When checked diagnostics will login to the SMTP server 
using secure authentication.

Username & Password

Specifies the username and password to use when 
secure authentication is enabled (see above).
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High and Low Priority Alarms

The rules associated with local alarms can be specified 
for both high and low priority units. 

Alarm Event Counters

Display Alarm after (n) alarm event(s)

Each time diagnostics polls a radio for its parameters 
it compares the returned result against the alarm 
detection limits as defined for that unit in the data base. 
Each instance where the result is outside the defined 
limits is declared an alarm. This parameter specifies the 
number of alarms (events) for a specific radio before an 
local alarm will be detected.

Sound alarm after (n) displayed alarm event(s)

This parameter allows an audible sound to be triggered 
after a configurable number of detected alarms. The 
audible sound can help indicate to PC or console 
operators an alarm has been detected.

Local Alarm Reporting Setup

Local alarms are detected diagnostics alarms that are 
displayed in the alarms output window on the PC screen. 
Diagnostics provides a configurable set of rules for 
displaying local alarms in the alarm window.

Acknowledged Alarms

When detected alarms are displayed in the “Local 
Alarms” window they will initially NOT be acknowledged. 
This is shown above.  To acknowledge a detected alarm, 
the check box (tick box) in the left column of the local 
alarm reporting window should be checked (ticked).

Do not acknowledged alarms

When ticked, acknowledged alarms will not be displayed 
in the local alarm output window. When not ticked, 
acknowledged alarms with be displayed as black in the 
local alarm output window. 

Do not sound alarm

Acknowledged alarms will not cause the audible sound to 
be triggered.

Clear Acknowledged Alarms

Users should be careful of acknowledging alarms if 
the “Do not display acknowledged alarms” option is 
ticked. Units that are alarming may disappear from the 
system if acknowledged alarms are not regularly reset to 
unacknowledged.

This option specifies the period after which acknowledged 
alarms return to the unacknowledged state.

Set Defaults

This parameter returns each configuration parameter 
within the window to default values.

Clear All Acknowledged Button

When pressed this button clears each acknowledged 
alarm. It provides a manual mechanism to reset the 
acknowledged alarms to unacknowledged.
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eDiags Port Settings

This menu is used in conjunction with the settings 
configured in the J-Series, Q Data Radio, terminal server 
or other Ethernet device that TView diagnostics is 
communicating with.

Computer Name

This is the network name of the computer that the 
diagnostics software is running on. It is provided for 
management purposes only.

Local IP

This is the IP address of the computer that the 
diagnostics software is running on. It should match 
the destination IP address set in the J-Series, Ethernet 
E-Series, terminal server or Ethernet device (The Q Data 
Radio will respond dynamically). Use a static IP address 
(i.e.: Not DHCP assigned addresses).

Many servers will have two or more network ports 
available. The Local IP entry box allows the user to 
specify which network port to use.

eDiags Port Number

This is the UDP port number TView+ Diagnostics uses for 
Ethernet responses from the J-Series, Q Data Radio or 
terminal server. Match the destination port as configured 
in the J-Series, Q Data Radio, terminal server or similar 
device.
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Polling

Overview

In order to obtain diagnostics information, the 
diagnostics controller provides a number of automatic 
polling facilities, which include: Group polling, Timed 
polling and Individual polling.  The Group and Timed poll 
facilities will automatically cycle through a selected group 
of units at a predetermined interval as specified in the 
Polling Setup menu. The Individual poll facility permits 
intensive polling of a single unit at a selectable rate, 
independent of any Group polling that may be active at 
the time. Individual polling also displays results in a bar 
graph format.

When a radio is polled for the first time, the controller 
will poll (ask) the radio for its calibration constants and 
firmware revision (these can be viewed in the “View” 
window under the File menu).  When this initialization 
procedure is complete, status polling can commence.  If 
the radio were to perform a “cold boot” (e.g. No power, 
cold boot command received, etc), the controller will 
detect this and initiate the above initialization procedure 
again and display “cold boot” alarm detection in “other”.

During group status polling which includes a Hot 
Standby unit, both radios will be polled. The offline unit is 
highlighted with an asterisk ( * ) prefix.

Status reports begin with information about the radio 
responding to the status poll requests:

• Unit Name

• Serial Number

• Location

• Model

• Type

The status poll requests that are reported and displayed 
on the main screen are:

• Temperature

• Received Signal Strength

• Transmitter Power

• DC Supply Volts

• Received Frequency Offset (D, E & Q  Only)

• VSWR (KR900, JR900, E & Q Only)

Alarm Detection

If the controller receives a status poll where the 
result (Temp, Rx Sig, Tx PWR, DC Volts or Freq Off) is 
outside the user defined alarm detection limits, the 
poll is declared to be an alarm and the information is 
displayed in the “Local Alarms” area. By Default, alarms 
are detected after three consecutive polls. This helps 
to reduce detection of erroneous alarms. The number 
of non-acknowledged poll attempts before an alarm is 
detected can be configured in the “Advanced -> Unit 
Settings” area of the unit database setup. 

Other detected alarms (not related to those mentioned 
above) may also cause an alarm condition. These polls 
are also displayed in the Local Alarm window with further 
details shown in the “Other” column. This includes:

No Ack : No response to a diagnostics poll 
Diags Not Installed : Diagnostics has not been installed 
on the unit being polled. 
Re-Boot : Radio has been re-booted since the last 
received diagnostics poll. 
Ports Halted : Radio ports have been disabled. 
Not Remote : Radio has been configured in the database 
as a remote but is detected as a base. 
Not Base : Radio has been configured in the database as 
a base but is detected as a remote. 
ERROR : Unknown or unexpected event. 
Switch Base : A Hot Standby Controller change over 
event has occurred.

Group Polling

In Group Polling mode, radios that are part of the Poll 
Group (See Settings - Poll Group select) are polled in 
succession. When diagnostics reaches the last radio in 
the poll group it returns to the top of the list.

Results are displayed in the “Status Polls” window along 
with the Unit Name and Time of the poll.

Timed Poll

In Timed Poll mode, TView+ diagnostics waits until the 
specified Poll Time (see Settings - Polling Setup) and 
then performs a group poll as per above. If configured, 
the group poll will be repeated until done and then 
TView+ waits for another 24 hours until the time expires 
again.
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Individual Poll

In Individual Poll mode, a specific unit is selected and 
polling (updating) can be manually controlled. Results 
are displayed in a bar graph and numerical format.

Individual polling may be performed simultaneously with 
Group or Timed polling is in progress.

Data Logging
This menu item allows advanced analysis of diagnostics data.

Log Status Polls
When ticked, status poll results are stored in the database.

Log Alarms
When ticked, detected alarm values are stored.

View History
The view history facility provides a facility to inspect 
diagnostics poll data for a specific unit.

From To or ALL Fields
These fields determine the time span you wish to view.  
For example, if you have collected several months of 
data, and only wish to view a 24 hour period, then adjust 
the From: and To: fields accordingly and select the unit.

When the History window first appears, the From: and 
To: fields will contain the last 24 hours of data.

If “ALL” is selected it will display the start and end dates 
of the database. The Date/Time format will be as per the 
regional settings short date format.

The smaller the time span you select, the faster the 
database search will be.

Sorting
Each of these tables can be sorted in ascending order 
by: unit, date or poll parameter.  To sort, just click on the 
required column header.

To show the status of a single report in the “Alarm 
History” click on the box at the left by the unit name. This 
only works on valid poll results not “NoAck”.

Printing
A printout of each table is possible by clicking on the 
associated Print button.  The table data will be sent to 
the default printer and formatted as per your default 
printer configuration set up.

View Trend
The logged status poll data can be viewed in graph 
format, which allows viewing of status trends over 
selectable time spans.  This provides a very effective and 
fast method of analyzing a unit’s operating parameters 
over time.

Select “View Trend” under the Data Logging menu item 
or click the associated toolbar button.

Features available include:

• Scaling of graph(s).

• View individual poll results using the cursor.

• Automatically scroll through the group poll 
database, unit by unit at a selectable time interval.

• No Acknowledge messages are displayed by a gap 
in the graphed data and a “NoAck” in the “Other” 
box on the Time Line.

Vertical Scale Setting

• Manually set the vertical scales by typing in the 
new level(s), then either press “Enter” or click on 
the “Re Draw” button, or select a new unit.

• Click the “Default Ranges” button to set the vertical 
scales back to the default levels.

• Click the “Set Ranges to Alarm Limits” button to set the 
vertical scale limits to the selected unit alarm detection 
limits.
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From: & To: Fields

These fields determine the time span you wish to view.  
For example, if you have collected several months of 
data, and only wish to view a 24 hour period, then adjust 
the From: and To: fields accordingly.

When the Trending window first appears, the From: and 
To: fields will contain the last 24 hours of data.

If “ALL” is selected it will display the start and end dates 
of the database.

The smaller the time span you select, the faster the 
database search and draw. This will also depend on the 
poll rate that was used during that time span.

Use the “ALL” button to set the From: and To: fields to 
the maximum and minimum dates found in the data in 
the database.

Poll Group Cycle

When toggled ON, this will step through each radio in 
the poll group and display the trend graph.  Set the 
step interval in the “Step Every (Sec)” field. Default = 2 
seconds

Cursor:  Use the slider control, found at the bottom of 
the display to move the cursor.  The cursor box displays 
the parameter data of the status poll at the current 
cursor position.

Use the “Set From” button to set the From: field to the 
current cursor position.

Use the “Set To” button to set the To: field to the current 
cursor position.

Tools

The tools menu provides useful system tools for 
diagnosing and maintaining a radio network using TView+ 
Diagnostics.

Statistical Performance

Under the statistical performance menu, three separate 
tools are provided. 

Packet Transmission Test

This tool provides a useful way to commission a radio 
communications link.

Packet transmission testing works by sending a known 
packet of information to the selected unit and looking 
for a response. Each time a response is not heard (or a 
response is received but is corrupted) the facility counts 
this as a lost packet. As soon as a response is heard 
from the remote unit, TView+ Diagnostics will wait the 
specified time between, then send another packet.

It is recommended that this test is run for at least 
500 packets in order to get a meaningful result that is 
statistically valid. It is best that no other data is being 
transmitted on the radio network during the test as this 
may skew results.

To use the packet transmission test facility, choose 
the unit you wish to test the link quality to by using the 
“Selected Unit” drop down box .

Activate the start button and the test will commence.

Tx Packets

This indicates the number of packets TView+ Diagnostics 
has transmitted to the remote unit.

Rx Packets

This indicates the number of packets TView+ Diagnostics 
has received from the remote unit.

Lost Packets

This indicates the number of packets TView+ Diagnostics 
has declared as lost. 

Error Percentage

This indicates the calculated Packet Error Rate in %. It is 
calculated from the ratio of Tx Packets to Rx Packets.

Normalised BER

This indicates the normalised BER (Bit Error Rate) based on 
the number of bits per packet assuming only one bit was 
corrupted. It is only an estimate since two corrupted bits in 
one packet will only be counted as one corrupted  bit.

Commissioning Record

For system commissioning and future records it is 
recommended to print a commissioning record. 
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Counters for Trio radios are listed below:

• Lost Synch - An event where RX cannot be decoded

• Lost RxSig - An event where Rx data is incomplete 

• Good Frames - A frame that contains received Data

• Bad Frames - A frame that has had the Checksum 
calculated incorrectly

• Time Ticker - Time period of counter data collection

• RSSI Ticker - Time period of received radio signal

• Channel Occupancy

• Channel OCC Sliding

• Channel Utilisation*

• Retry count

• Abandoned Packets

• Abandoned Tokens

Some counters are hardware specific.

*Receiver Channel Utilisation is not available in Q data 
radios. This counter is designed for use with E-Series only.

The TView+ diagnostics software can use these statistics 
to help calculate network efficiency, bandwidth utilisation 
and radio link integrity.  These network analysis features 
are an invaluable tool for larger networks.

Update Counters: updates the statistical performance 
counters by reading them from the currently selected unit.

Reset Counters: resets the statistical performance 
counters in the radio.

RF Data Rate: Select from the pull down menu 4800, 
9600 or 19200 bps, depending on your system settings 
(some radio types auto-populate this box).

Status Bar

Reports any poll processing in progress or can display 
un-expected events that may have occurred.

Auto Poll

When ticked, this option automatically updates the 
statistical performance counters for the selected unit 
(time between updates depends on type of radio)

Log Counters 

When ticked, this option logs the counters every time 
they are updated.  These can be viewed on the “Counter 
Poll History” Tab.

Notes:

• The controller will attempt a series of polls when 
either resetting or retrieving the counters.  A user 
should monitor the status window for the poll process 
to be complete. If an un-expected event occurs, this 
may be due to conditions like packet collisions on a 
busy network, diagnostic controller trying to perform 
too many poll functions (i.e. group polling, individual 
polling), etc.

• E, M, J & K Series data radios have 32 bit counters 
and will count for 1 year, 4 months & 10 days if no 
reset occurs.

• If an HSC Base is selected, the counters displayed 
only correspond to that base (whether offline 
or online). Select the alternate base to read the 
counters from it. With D Series pairs, data can only 
be collected from the online unit. 

Counter Poll History Tab

This is a database viewing facility. Enabled by ticking “Log 
Counters”, each time the counters are retrieved they will 
be written to the database.  Adjust the From: & To: fields 
to view a specified time span or press ALL to obtain 
complete database period.

Statistical Performance Formulae

Timers:

Real Time Ticker 
(RTT) [10mS]

timer that increments by one 
every 10mSec

Elapsed Time Total elapsed time in hh:mm:ss 
from reset calculated from RTT

Receive Channel:

Good Frames Good frames received by radio. 
The frame CRC was correct.

Bad Frames Bad frames received by radio. The 
frame CRC was incorrect. 

Good Bytes Good byte received (from good 
frames)

Average Frame Size GoodByteCnt / GoodFrameCnt

Average Frame 
Rate (mSec)

(GoodFrameCnt + BadFrameCnt) 
/ RTT * 0.01

Channel 
Occupancy (%)

RSSIgoodTicker / RTT * 100 

Channel 
Occupancy Sliding

RSSIgoodTicker / (time since last 
poll) * 100

Rx Channel 
Utilisation (%)

(GoodByteCnt * 8) / (RTT * 
RFChannelBitRate)

Transmit Channel:

Tx Frames Number of Tx HDLC frames.

Tx Byte Number of Tx bytes

Average Frame Size TxByteCnt / TxFrameCnt

Average Frame 
Rate (mSec)

 TxFrameCnt / RTT * 0.01

Tx Channel 
Utilisation (%)

(TxByteCnt * 8) / (RTT * 
RFChannelBitRate)

Performance Counters

Schneider Electric Trio radios store packet statistics for 
later retrieval and analysis. These are viewed by selecting 
Tools > Statistical Performance > performance Counters 
( E Series Counter Window shown below)
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Alarm Status

The alarm status information provides a reflection of 
the active alarms on a hot standby radio’s controller, 
therefore this is only displayed in the ‘Hot Standby Base/
Repeater Controller (HSC)’ window.

Hot Standby Base/Repeater Controller (HSC)

Hot Standby radios implement a specific set of features 
and controls that can be accessed via this menu system.

When this option is selected, TView+ Diagnostics shows 
a list of available Hot Standby Controllers available from 
within the database (if not hot standby radios have been 
entered and pair, a message will be displayed).

Select the Hot Standby Controller you wish to access 
using the drop down selection box.

Once selected, the diagnostics software will attempt to 
connect to the radio. If successful, the ‘Hot Standby Base/
Repeater Controller (HSC) window will open.

Base A/Base B

After successful communication between the 
Diagnostics software, and the hot standby radio, 
Base A and Base B fields will be populated with the 
corresponding radio names and serial numbers.

Base Select

This indicates the online status of each unit.

LED Colour Switch Select State

Off Channel not selected (Offline)

Green Online (Automatic). Automatic 
changeovers will be actioned by the 
HSC in response to detected alarms.

Green Blinking Change Over Pending. Waiting for 
one minute time-out period before 
switching to offline base.

Red Selected by TView+ (Remotely).  
Auto changeovers will not occur.

Amber Selected by Switch on HSC (On site).  
Auto changeovers will not occur.

Providing either of the bases is not forced online by the 
switch, the user can force either of the bases online 
remotely by pressing Base Select button 1 or 2.  The 
user can revert back to Automatic mode by clicking on 
the Base Select Auto button.

If the user attempts to switch bases within one minute of 
a base changeover event, the change pending indication 
will appear (i.e. Online Unit LED Blinking Green).  The user 
should then wait until the change over event occurs.

Change Over Events

This is a counter which indicates the number of 
automatic change over events initiated by the HSC due 
to detected alarms. This can be reset using the ‘Reset 
Alarms - Base A/B’ button (on the corresponding radio).

Alarm Status

The current alarm detection status (since the last alarm 
status poll) for the attached Base units is displayed below.

LED colour Status

Off Unknown.  Has not been tested.

Green No Alarm detected.

Red Active Alarm detected.

Amber Recovered Alarm. Alarm detected 
previously but has since recovered.

Latched Alarms

Latched alarms are those that will not reset back to a 
recovered state, but will remain in an active alarm state 
until they have been reset.

Reset Alarms - Base A/B

Pressing this button will clear the change over event 
counter and the alarms status displayed For the 
corresponding radio.
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RSSI Ticker 
(10mS)

timer that increments by one 
every 10mSec when RxSig 
present. (Virtual connection to 
RxSig LED)

Digital I/O Status

The digital I/O status is available within the following 
windows:

• Hot Standby Base/Repeater Controller (HSC) 
[Which is shared with the Alarm Status Window]

• Base/Repeater Digital I/O 

• Remote Digital I/O

Example of Base Repeater Digital I/O Window:

Digital I/O Status

Displays digital I/O input and output status.

Depending on the radio model, 2 or 3 Digital I/O will be 
available.

Digital I/O Toggle Buttons

Clicking these buttons will toggle the associated output 
state.

Toggling the outputs of a HSC is a good way to 
determine if the HSC is still online. If the toggled output 
state doesn’t change, this will be indicated in the status 
message bar at the bottom of the HSC window.

Logging Toggle

When logging is ON, status data including digital I/O is 
stored in the database. 

No Acknowledge 

The Hot standby has not responded to diagnostic 
polls. Typically, both bases are tried 3 times each (as 
configured in database).

Re-Booted 

The online Base connected to the HSC has been re-
booted. 

Unit is a remote 

The Unit has been entered in the database as a Base, 
but is factory set as a Remote.

Un-expected Event

Unforeseen events can be captured, with relevant data 
stored in the ‘Error.log’ file.

<Base Name> [<Serial>] is Forced Online by switch

When a base is forced online by the switch, remote 
switching of bases is not possible using TView+ 
Diagnostics.

Base1/Base2 already forced online

An attempt was made to force a base online that 
has already been forced online remotely by TView+ 
Diagnostics.

Already in Auto mode

The Auto button was pressed when the HSC was already 
in auto mode.

Output Toggle Process Indication.

The Digital  window can indicate when digital output 
state toggling has been successful or not. An indication 
of a non successful digital output toggle can help 
diagnose the online status of the HSC.

Example of Remote Digital I/O Window:

Update Now

Pressing this button will immediately initiate a status poll 
sequence and on successful receipt of a status poll the 
display will update.

Poll State Toggle Button

• Switches automatic status polling ON or OFF.  The poll 
rate is set via the Setup -> Poll Settings menu item. 

• The poll rate is dependent on the number of HSC 
windows that are actively polling.

Changeover Pending. Wait up to one minute. 

A change over attempt has been made by either the 
HSC or a remote TView+ Diagnostic controller within one 
minute of a previous change over event.  A change over 
to the offline unit will not occur until the one minute time 
period has expired.

Base 1 and Base 2 connection state corrected. Up 
until the first time an HSC is communicated with, the 
Diagnostic controller doesn’t know which of the paired 
bases in connected to HSC ports One and Two.  So the 
paired Bases are displayed in alphanumeric order.  The 
display is corrected on reception of the first message 
from either Base.
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Trace Route  (J & K Series Only)

The Trace Route facility allows you to view the radio 
path your messages are taking. “This is most useful in 
networks including SmartPath (redundant) networks.

The Trace Route Tool can be found under -> Tools, 
Trace Route...

Once you have selected the Trace Route Tool, a 
separate window will appear.

Selected Unit

This parameter allows you to select which Unit you want 
to see a trace route of. Typically remote units will be 
selected.

Model

The Model window displays which type of radio the 
selected unit is, i.e. J-Series or K-Series etc.

Type

The type window displays what type the selected model 
is in, i.e an E-Series can be either a remote type or a base 
type and a K-Series can be a Master, Bridge or remote 
type.

Last Successful Poll

The Last Successful Poll window displays the date/time 
of the last successful poll of the selected unit.

Selected Unit Model Type

Last Successful Poll Poll Repetition Time Polling

Poll Repetition Time

This parameter allows the user to select the frequency 
of the trace route polls. This is measured in seconds, i.e 
using a value of 10, will poll the selected unit every 10 
seconds.

Polling

This parameter allows the user to toggle the trace route 
polling ON or OFF.

The Trace route facility will display the radios in the 
selected unit’s radio path. This is displayed in text in the 
main window of the trace route window.

Example: This example has been taken of a K-Series 
remote, from a master type K-Series, through four Bridge 
type K-Series.
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Interpreting Poll Results

General

The results returned by the poll requests can help give 
an indication of system performance.  When a new radio 
is added to the database, default values are assigned 
for the limits of the returned results. The user can assign 
different values to these limits as required, which is 
determined by the tolerance of their system.

RSSI

The default RSSI limits are set at -30 to -105 dBm (-110 
dBm for Base/Repeater Station).  Above -30 dBm the 
front end of the receiver will saturate and it is unlikely that 
signal levels much higher than this will ever be reported. 

RSSI alarm detection limits should be set for radios based 
on the values within the commissioning report. If during 
commissioning a remote site was found to have a signal 
strength of -75 dBm, then it would be a sensible idea to 
set the alarm detection limits to -70 dBm and -80 dBm. 

There is generally no point in setting tight alarm 
detection limits for radios which receive signals from 
many remote sites, such as Base/Master/Repeater radios. 

The RSSI level is taken from the unit’s last successfully 
received message. Keep this in mind when you are trying 
to interpret the RSSI level of a master radio in a PTMP 
system.

Transmitter power

For a J/K radio, the transmitter alarm limits are set at 
between 27 dBm and 33 dBm.  The radios will normally 
be operating at a power level of 30 dBm. 

The reported transmit power is a value of the last 
transmission made by the radio. When the PTT is ON a 
periodic measurement is made of the transmit power.  
The radio stores this away and reports it when requested.

If no transmission has occurred since power up or reset,  
the radio will report 0dBm. 

Temperature

Alarm detection limits for this option may be configured 
to meet the individual requirements for each site, but 
in general it is recommended to set an upper limit that 
matches the maximum acceptable temperature. 

The temperature alarm detection limit may also be set 
based on an air-conditioned environment. Should the air 
conditioning stop, an alarm could be detected when the 
radio exceeds the temperature specified in the alarm 
detection limit. 

Supply Voltage

The DC supply voltage alarm detection limits should be 
set according to the operating range of the radio and 
the DC power supply in use. For details on the operating 
range of each radio consult the appropriate data sheet 
(which can be found towards the end of the User 
Manual).

The lower DC Supply Voltage alarm detection limit can 
also be set such that if mains power is lost at a site with 
battery backup, diagnostics can indicate a detected alarm.

Frequency Offset

Available in E & Q Data Radios.

The frequency limits are set to 3000Hz. This is the 
difference between the different ends of a data link.  If 
the difference gets much greater than this, radio link 
performance may be affected.

The radio will have a degree of long term frequency drift 
of 1ppm (0.8ppm for Q data radios) / annum due to the 
physical properties of internal components. 

VSWR 

Available in E, Q, KR900 & JR900 Data Radios.

Voltage standing wave ratio (VSWR) indicates how 
well the RF load (antenna/filter/cables) is impedance 
matched to the radio transmitter.  A value approaching 
1.0 will result in good transmit performance.  If the 
connection between the antenna and the radio is poor 
then a high VSWR will be reported by diagnostics. The 
default high VSWR alarm detection is set to 3.0
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Part D – Appendices
Microsoft Excel Database Query Example

This query will list status data (i.e. Temperature, Volts, Rx 
Signal Strength, Rx Frequency Offset, Tx Forward Power, 
and Tx Reverse Power) for a specified serial number 
occurring between specified date ranges.

Two database queries will be required.  The first; to retrieve 
one record from the RadioTable containing the radio name 
and location for the specified serial number. The second; 
to retrieve a range of records from the StatusPoll table for 
the specified serial number, between and including the 
specified dates.

1. Open a new workbook in Excel.

2. In cell A1 enter the following text: “Serial Number”

3. In cell A2 enter a serial number that exists in the  
 database: e.g. 20061

4. In cell A4 enter the text: “Start Date:”

5. In cell A5 enter the text: “End Date:”

6. Highlight cell B4 and B5 and set the number   
 format to: “dd-mm-yy hh:mm:ss”

7. In cell B4 enter a suitable start date, e.g.  23-04-03  
 14:57:00

8. In cell B5 enter a suitable end date, e.g.  23-04-03  
 15:00:00

The date range fields can limit the query result to a 
manageable number of rows.  In this case the query result 
will contain records between and including the dates 23-
04-03 14:57:00 to 23-04-03 15:00:00.

9. From the Data Menu, select ‘Import External Data  
 —> New Database Query..’

 The Choose Data Source window will appear:

10. Uncheck the ‘Use the Query Wizard to create/edit 
queries’ box.

11. Select the DNS ‘Schneider Electric’, which was 
created in Data Sources earlier.

12. Click OK. The Microsoft Query Application 
appears, with the Add Tables selection box on 
top.

13. Select and Add the ‘Radio’ table.

 The Radio Table will appear on the Microsoft 
Query screen.

14. Click on the Close button.

15. In the Radio table, find the ‘UnitName’ field and 
double click on it to add this field to the query.

16. Similarly, add the ‘Location’ field to the query.

17. From the view menu select ‘Criteria’, to view the 
criteria window.

18. In the criteria field of the first column, enter field 
name ‘Serial’ (use the pull down selection list).

19. In the value field, enter the following text: “[Enter 
serial Number]”. When the query is run, a prompt 
will appear containing this message. You need to 
enter an existing serial number for the query to 
work.

20. From the Records menu choose ‘Query Now’ 
to run the query. Your screen should appear 
something like this:
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23. Back at the spreadsheet, an ‘Import Data’ window 
appears prompting for a cell location. Put the 
cursor in cell B1.

24. Click on the ‘Parameters’ button.

25. Click on the ‘Get the value from the following cell 
button.

26. Place the cursor on the serial number in cell A2.

27. Review the ‘Refresh automatically when cell value 
changes’ check box is ticked, then press OK.

28. Press OK on the ‘Import Data’ window. The 
Spreadsheet should appear something like the 
following:

You can do another query with a different serial number 
simply by changing the number in cell A2.  The Unit 
Name and Location data will automatically update.

21. Save the query as ‘Get Radio Detail.dqy’

22. From the File menu select ‘Return Data to 
Microsoft Excel’

Query Status Poll data

The next Query will list the status data for the unit serial 
number in A2, occurring between and including the 
dates specified in cells B4 and B5.

1. To query the StatusPoll table, return to step 9 
and follow each step until you have completed 
step 12, then return here. The Microsoft Query 
Application appears, with the Add Tables 
selection box on top.

2. Select and Add the ‘StatusPoll’ table. The 
StatusPoll Table will appear on the Microsoft 
Query screen.

3. Click on the Close button.

4. In the StatusPoll table, find the ‘Epoch’ field and 
double click on it to add this field to the query.

5. Similarly, add the Volts, Temp, RSSI, FreqErr, 
TxPWR and TxPWRrev fields to the query.

6. From the view menu select ‘Criteria’, to view the 
criteria window.

7. In the criteria field of the first column, enter field 
name ‘Serial’ (use the pull down selection list).

8. In the value field, enter the following text: “[Enter 
Serial Number]”.

9. In the criteria field of the second column, enter 
field name ‘Epoch’ 

10. In the value field under Epoch, enter the following 
text: “>=[Enter First Date] AND <=[Enter Last 
Date]”

11. From the Records menu choose ‘Query Now’ 
to run the query.  You will be prompted for an 
existing serial number, start date, and end date.

 Your screen should appear something like this:
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12. Save the query as ‘Get Status Data.dqy’

13. From the File menu select ‘Return Data to 
Microsoft Excel’

14. Back at the spreadsheet, an ‘Import Data’ window 
appears, prompting for a cell location. Put the 
cursor in cell D1.

15. Click on the ‘Parameters’ button.

16. Select ‘Enter Serial Number’ from selection list box.

a. Click on the ‘Get the value from the following cell.

b. Place the cursor on the serial number in cell A2 
and select.

17. Select ‘Enter First Date’ from selection list box.

a. Click on the ‘Get the value from the following 
cell.

b. Place the cursor on the date in cell B4 and 
select.

18. Select ‘Enter Last Date’ from selection list box.

a. Click on the ‘Get the value from the following 
cell.

b. Place the cursor on the date in cell B5 and 
select.

19. Review the ‘Refresh automatically when cell value 
changes’ check box is ticked for each field, then 
press OK.

20. Place the cursor in cell D1, then press OK.

The Spreadsheet should appear something like the following:

Changing the Serial Number in cell A2 will automatically 
update the displayed data.  Similarly, changing either the 
Start or End Dates will automatically update the Status 
Poll Data.

In the figure below, see that the columns have been 
averaged using the spreadsheet AVERAGE function, and 
an additional query has been included. 

The new query selects the last received poll for the 
specified serial number and displays the associated data.  

The Max query function is used on the Epoch field to 
get the last poll date.  This query has been configured to 
refresh every minute.

An additional element has been added to the 
spreadsheet, which calculates the VSWR from the last 
poll data.

To fine tune, or to generate more complex queries you 
can display and edit the SQL statements corresponding 
to the queries previously created in Microsoft Query by 
selecting ‘SQL…’ from the view menu.

This figures shows the SQL select statement 
corresponding to the query described in steps 29 to 40.
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Microsoft Access (.mdb) Structure

Table Definitions

Table 1.0 - Radio
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Table 4.0 - AlarmCode

Table 2.0 - Status Poll

Table 3.0 - Alarm
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Table 4.1 - AlarmCode

Table 5.0 - Retries Table 5.1 - Poll Type
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Table 6.0 - Poll Type

Table 7.0 - Counter

Table 8.0 - HSC

Table 9.0 - HSCAlarmState
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Table 10.1 - HSCchannelState

Table 11 - HSCstatus

Table 12.0 - EBaseStatus

Table 10.0 - HSCchannelState

Table 9.1 - HSCAlarmState

Table 13.0 - Alarm Status
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Part E – Support Options

© 2017 Schneider Electric. All rights reserved. Schneider Electric is a trademark owned by Schneider Electric Industries SAS 
or its affiliated companies. All other trademarks are the property of their respective owners - May 2017. 
Document number 0100SM1402

Manufactured by Trio Datacom Pty Ltd 
(a wholly owned company 
of Schneider Electric) 
415 Legget Drive, Suite 101, 
Kanata, Ontario, K2K 3R1, Canada    
Printed in Canada

When e-mailing questions to our support staff, please provide the exact model number (and serial number if possible) of the 
Trio equipment you are working with. Include as much detail as possible about the situation including radio configuration files, 
diagnostic database and system diagrams, also any tests that you have done which may help us to better understand the 
issue. If possible, include your telephone contact information should we wish to further clarify any issues.

Technical Support: The Americas, Europe, Middle East, Asia
Available Monday to Friday 8:00am - 6:30pm Eastern Time 
Toll free within North America: 1-888-226-6876 
Direct Worldwide: +1-613-591-1943 
Email: SupportTRSS@schneider-electric.com

Technical Support: Australia 
Inside Australia: 1300 369 233
Email: au.help@schneider-electric.com
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